Thank You for Choosing Ross

You've made a great choice. We expect you will be very happy with your purchase of Ross Technology.

Our mission is to:

1. Provide a Superior Customer Experience
   • offer the best product quality and support

2. Make Cool Practical Technology
   • develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and empowers our employees. I hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to your expectations be sure to reach out to us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics

Any company is the sum total of the people that make things happen. At Ross, our employees are a special group. Our employees truly care about doing a great job and delivering a high quality customer experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our behavior:

1. We will always act in our customers' best interest.
2. We will do our best to understand our customers’ requirements.
3. We will not ship crap.
4. We will be great to work with.
5. We will do something extra for our customers, as an apology, when something big goes wrong and it's our fault.
6. We will keep our promises.
7. We will treat the competition with respect.
8. We will cooperate with and help other friendly companies.
9. We will go above and beyond in times of crisis. *If there's no one to authorize the required action in times of company or customer crisis - do what you know in your heart is right. (You may rent helicopters if necessary.*)
NK-NET · User Guide

• Ross Part Number: 2201DR-002-05
• Release Date: December 5, 2017.

The information contained in this Guide is subject to change without notice or obligation.

Copyright

©2017 Ross Video Limited, Ross®, and any related marks are trademarks or registered trademarks of Ross Video Limited. All other trademarks are the property of their respective companies. PATENTS ISSUED and PENDING. All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, mechanical, photocopying, recording or otherwise, without the prior written permission of Ross Video. While every precaution has been taken in the preparation of this document, Ross Video assumes no responsibility for errors or omissions. Neither is any liability assumed for damages resulting from the use of the information contained herein.

Patents


Notice

The material in this manual is furnished for informational use only. It is subject to change without notice and should not be construed as commitment by Ross Video Limited. Ross Video Limited assumes no responsibility or liability for errors or inaccuracies that may appear in this manual.

Trademarks

Intel® is a trademark of Intel Corporation in the U.S. and/or other countries.
Microsoft®, Windows®, and Windows XP® are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.
Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

Safety Notices

Refer to the “Important Regulatory and Safety Notices” document that accompanied your product.

Statement of Compliance

This product has been determined to be compliant with the applicable standards, regulations, and directives for the countries where the product is marketed.

Compliance documentation, such as certification or Declaration of Compliance for the product is available upon request by contacting techsupport@rossvideo.com. Please include the product; model number identifiers and serial number and country that compliance information is needed in request.
EMC Notices

US FCC Part 15
This equipment has been tested and found to comply with the limits for a class A Digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a Commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

Notice — Changes or modifications to this equipment not expressly approved by Ross Video Limited could void the user’s authority to operate this equipment.

Canada
This Class A device complies with Canadian ICES-003 rules.

Cet appareil numérique de la classe “A” est conforme à la norme NMB-003 du Canada.

European Union
This equipment is in compliance with the essential requirements and other relevant provisions established under regulation (EC) No 765/2008 and Decision No 768/2008/EC referred to as the “New Legislative Framework”.

Warning — This equipment is compliant with Class A of CISPR 32. In a residential environment this equipment may cause radio interference.

Australia/New Zealand
This equipment is in compliance with the provisions established under the Radiocommunications Act 1992 and Radiocommunications Labeling (Electromagnetic Compatibility) Notice 2008.

Korea
This equipment is in compliance with the provisions established under the Radio Waves Act.

Class A equipment (Broadcasting and communications service for business use).

This device is a business-use (Class A) EMC-compliant device. The seller and user are advised to be aware of this fact. This device is intended for use in areas outside home.

<table>
<thead>
<tr>
<th>Type of Equipment</th>
<th>User’s Guide</th>
</tr>
</thead>
<tbody>
<tr>
<td>A급 기기 (업무용 방송통신기자재)</td>
<td>이 기기는 업무용(A급) 전자파적합기로서 판매자 또는 사용자는 이 점을 주의하시기 바라며, 가정외의 지역에서 사용하는 것을 목적으로 합니다.</td>
</tr>
<tr>
<td>Class A Equipment (Industrial Broadcasting &amp; Communication Equipment)</td>
<td>This equipment is Industrial (Class A) electromagnetic wave suitability equipment and seller or user should take notice of it, and this equipment is to be used in the places except for home.</td>
</tr>
</tbody>
</table>

International
This equipment has been tested under the requirements of CISPR 22:2008 or CISPR 32:2015 and found to comply with the limits for a Class A Digital device.

Notice — This is a Class A product. In domestic environments, this product may cause radio interference, in which case the user may have to take adequate measures.
Warranty and Repair Policy

The product is backed by a comprehensive one-year warranty on all components.

If an item becomes defective within the warranty period Ross will repair or replace the defective item, as determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis, plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages (including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose, are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.

Extended Warranty

For customers that require a longer warranty period, Ross offers an extended warranty plan to extend the standard warranty period by one year increments. For more information, contact your regional sales manager.

Environmental Information

The equipment may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional waste administration. You can also contact Ross Video for more information on the environmental performances of our products.
Company Address

Ross Video Limited
8 John Street
Iroquois, Ontario
Canada, K0E 1K0

Ross Video Incorporated
P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office: (+1) 613 • 652 • 4886
Fax: (+1) 613 • 652 • 4425

Technical Support: (+1) 613 • 652 • 4886
After Hours Emergency: (+1) 613 • 349 • 0006

E-mail (Technical Support): techsupport@rossvideo.com
E-mail (General Information): solutions@rossvideo.com
Website: http://www.rossvideo.com
# Contents

## Introduction  
9  
- Documentation Conventions ................................................................................................................. 9  
- Interface Elements ................................................................................................................................. 9  
- User Entered Text ................................................................................................................................. 9  
- Referenced Guides ................................................................................................................................. 9  
- Menu Sequences ..................................................................................................................................... 9  
- Important Instructions ........................................................................................................................... 9  
- Contacting Technical Support .............................................................................................................. 10

## Installation  
11  
- NK-NET Components .......................................................................................................................... 11  
- Overview ............................................................................................................................................... 11  
- NK Switchboard in DashBoard ............................................................................................................ 11  
- T-BUS Control System ......................................................................................................................... 11  
- Power Supply ........................................................................................................................................ 12  
- Connecting the NK-NET ....................................................................................................................... 12  
- Connecting the NK-NET to a Network ................................................................................................. 12  
- Connecting the NK-NET Direct to a PC .............................................................................................. 13  
- Connecting the NK-NET to NK Series Devices .................................................................................. 14  
- Installing DashBoard .......................................................................................................................... 14  
- Upgrading the Firmware Version ....................................................................................................... 14

## Configuration and Operation  
15  
- Default Configuration ............................................................................................................................ 15  
- Ethernet LEDs ........................................................................................................................................ 15  
- Locating Devices Using Walkabout ..................................................................................................... 16  
- Adding an NK-NET to DashBoard ....................................................................................................... 16  
- NK-NET Configuration .......................................................................................................................... 17  
- NK-NET Tab .......................................................................................................................................... 17  
- NK Switchboard Configuration and Operation ...................................................................................... 22  
- Switching ............................................................................................................................................... 23  
- Source, Destination, and Level Buttons ............................................................................................. 23  
- Configure IPS ......................................................................................................................................... 24

## Using an NK-VCP  
25  
- NK Virtual Control Panel Overview ................................................................................................... 25  
- Starting the NK-VCP .............................................................................................................................. 25  
- Adding an NK-NET .................................................................................................................................. 25  
- Source, Destination, and Level Buttons .............................................................................................. 26  
- Switching ............................................................................................................................................... 27  
- Protecting Outputs ............................................................................................................................... 27  
- Machine Control Button ....................................................................................................................... 27  
- Installing NK-VCP .................................................................................................................................. 27  
- System Requirements ............................................................................................................................ 28  
- Installing the Java Runtime Environment (JRE) ................................................................................ 28

## Configuring Basic System Network Connections  
29  
- Control an NK Router Over the Network Using an NK-NET and RCP-ME/QE .................................... 29  
- Join a Router to the System Over the Network Using Two NK-NETs .................................................. 30
Connect an RCP-ME/QE to an Existing NK System that Includes an NK-IPS ..............................................................31
Use an NK-NET to Connect Another NK Router Over Ethernet .........................................................................................32
Use an NK-NET to Connect an Additional RCP-ME/QE Over Ethernet ...........................................................................33

Troubleshooting

NK-NET ..................................................................................................................................................................35
Network/Connection Problems ......................................................................................................................................35
GVG Settings ..........................................................................................................................................................35
NK-VCP ..................................................................................................................................................................35
Error Messages ........................................................................................................................................................35
Network/Connection Problems ......................................................................................................................................36
General Problems ....................................................................................................................................................36
Introduction

This guide is for installers and operators of the Ross Video NK-NET. It provides instructions on how to connect the NK-NET into your routing switcher system, how to configure the NK-NET. It assumes that you are experienced with general broadcast concepts, and that you are familiar with the planning requirements for a routing switcher system.

This guide includes the following chapters:

• “Introduction” summarizes the guide and provides important terms, and conventions.
• “Installation” provides guidelines and instructions for physically installing your NK-NET.
• “Configuration and Operation” provides instructions for displaying the NK-NET in DashBoard, and configuring the NK-NET.
• “Using an NK-VCP” outlines how to use the NK Virtual Control Panel (NK-VCP) with the NK-NET.
• “Configuring Basic System Network Connections” briefly describes the steps to create the connections necessary to establish a basic system configuration using the RCP-ME/QE and NK devices.
• “Troubleshooting” provides tips on troubleshooting some common problems.

If you have questions pertaining to the operation of NK-NET, contact us at the numbers listed in the section “Contacting Technical Support”. Our technical staff is always available for consultation, training, or service.

Documentation Conventions

Special text formats are used in this guide to identify parts of the user interface, text that a user must enter, or a sequence of menus and sub-menus that must be followed to reach a particular command.

Interface Elements

Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For example:

In the Save As dialog, click OK.

User Entered Text

Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.

Referenced Guides

Italic text is to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the DashBoard User Guide.

Menu Sequences

Menu arrows are used in procedures to identify a sequence of menu items that you must follow. For example, if a step reads “File > Save As,” you would click the File menu and then click Save As.

Important Instructions

Star icons are used to identify important instructions or features. For example:

 ★ The NK-NET resets if configuration items are changed.
Contacting Technical Support

At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as the nearest telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. After-sales service and technical support is provided directly by Ross Video personnel. During business hours (Eastern Time), technical support personnel are available by telephone. After hours and on weekends, a direct emergency technical support phone line is available. If the technical support person who is on call does not answer this line immediately, a voice message can be left and the call will be returned shortly. This team of highly trained staff is available to react to any problem and to do whatever is necessary to ensure customer satisfaction.

- **Technical Support**: (+1) 613-652-4886
- **After Hours Emergency**: (+1) 613-349-0006
- **E-mail**: techsupport@rossvideo.com
- **Website**: http://www.rossvideo.com
Installation

NK-NET Components

Overview

NK-NET, with the DashBoard control system software, provides Ethernet connectivity to T-BUS supported NK routing system devices, enhancing the capability of any installed Ross products by providing access to the entire range of functions.

Figure 1.1 NK-NET — Front View

The NK-NET offers the following features:

- Enables Ethernet configuration of any TBus connected device from DashBoard.
- Allows you to configure both the router and up to four Ethernet connected panels.
- Supports 1 DashBoard client connection plus 5 connections to any other device.
- Support for NK-Client (expansion of NK-NET available connections)
- Replaces the need for an NK-IPS for simple router installations.

The NK-NET requires the router to host the connection, and therefore does not support panels directly. However, the NK-NET does support Ethernet panel linking and Ethernet to TBUs panel linking. If setting up advanced mapping, the NK-VRC virtual routing core is required. NK-NET does not support MC-1 or Carbonite eXtreme.

★ NK-NET mimics an NK-IPS when it communicates with other devices and software. As such, some actions and settings involving the NK-NET are done under “NK-IPS” in other devices and software (for example, the Configure IPS dialog box and NK-IPS Connection window in DashBoard).

NK Switchboard in DashBoard

The NK Switchboard, accessible through DashBoard, acts as a virtual panel for any router device. NK Switchboard enables control of multiple NK Series routers through NK-NET.

For More Information on...
- the NK Switchboard, refer to “NK Switchboard Configuration and Operation” on page 22 or the NK Series plug-in Help File in DashBoard.

T-BUS Control System

The NK-NET connects and translates data from NK devices on the T-BUS Control System (a multi-drop RJ-45 control system supporting collision detection and half-duplex communication) to DashBoard via TCP Ethernet. The T-BUS Control System minimizes cable connections between devices, acting as both a reliable means to provide phantom power to devices and as the communications line between NK devices.

Devices on the T-BUS Control System with collision detection support ensure that if two devices transmit messages at the same time they will not send incorrect data to other devices on the line. T-Bus devices that support collision
detection are able to monitor communication on the line to ensure that no two devices are transmitting at the same time.

**Power Supply**

The NK-NET receives phantom power from the router to which it is connected. Power consumption is limited to the power available over the T-BUS Control System from the router to which it is connected. However, the NK-NET cannot receive power from control panels or any other T-BUS devices that have PSUs but do not send power over T-BUS.

**Connecting the NK-NET**

The NK-NET has RJ-45 connectors for both Ethernet and T-BUS to allow connecting T-BUS devices to an Ethernet network. The typical use case is illustrated in *(Figure 1.2)*.

- The NK-NET does not require Internet access for operation, but it does require TCP network access. DashBoard software is required for configuration.

![Figure 1.2 NK-NET Connectivity](image)

**Connecting the NK-NET to a Network**

The NK-NET can be connected directly to a network for configuration purposes. It is recommended that the NK-NET be connected directly to the network so that it can be interfaced from almost any computer on that network (the configuration information in “Configuration and Operation” on page 15 assumes that the NK-NET has been connected directly to a network).

After a physical connection has been established, Walkabout can be used to configure the network settings for the NK-NET.

- If difficulties or problems are experienced when connecting the NK-NET to a network hub, or with assigning IP addresses, contact your network administrator.
Establishing a Physical Connection

When connecting the NK-NET directly to the network, a standard CAT 5/5e/6 cable must be used to connect the NK-NET to the network.

**To connect the NK-NET**
1. Connect one free end of the cable to a free port of the network hub.
2. Connect the other free end of the cable to the Ethernet port on the rear of the NK-NET.
3. Connect the cable from the T-BUS system to the T-BUS port.

Connecting the NK-NET Direct to a PC

The NK-NET can be connected to a single PC (a computer that is on a network) or standalone PC (a computer that is not on a network) for configuration purposes.

If a PC that is on a network is used to interface the NK-NET, a spare network card is required to connect the two (the other network card is used to communicate with the network).

If a PC that is not on a network is used to interface the NK-NET, only one network card is required to connect the two.

After a physical connection has been established, the IP address of the PC can be configured and can be used to configure the IP address for the NK-NET.

* If difficulties or problems are experienced when connecting the NK-NET to a network hub, or with assigning IP addresses, contact your network administrator.

Establishing a Physical Connection

When directly connecting the NK-NET to either a single or a standalone PC the following points must be taken into consideration:

- The NK-NET utilizes an auto-MDIX interface and can configure itself if it detects a direct connection to another ethernet end point such as a PC. A special crossover cable is not required.
- If a small standalone Ethernet hub is accessible, two standard Cat 5/5e/6 cables can be used. The first cable is used to connect the PC to the Ethernet hub, while the second connects the Ethernet hub to the NK-NET.

The Walkabout program must be used to discover an NK-NET on the network. The NK-NET network settings can then be configured in Walkabout. Once the NK-NET settings have been configured using Walkabout, the NK-NET can be manually added to Device Finder if the network settings of the NK-NET are on the same subnet.

**To connect the NK-NET to a single PC that is on a network or a standalone PC that is not on a network**
1. Connect one free end of the CAT5 crossover cable to the free network card of the PC.
2. Connect the other free end of the CAT5 crossover cable to the Ethernet port on the rear of the NK-NET.

Configuring the PC IP Address

Once either a single PC or a standalone PC has been physically connected to the NK-NET, the IP address for both the PC and the NK-NET needs to be configured. It is recommended that users familiar with networking configure the IP addresses for both a single and a standalone PC, as well as the NK-NET.

* This topic only applies to single or standalone computers connecting to the NK-NET; it does not apply when the NK-NET is connected directly to the network.

* NK-NET does not support DHCP. Use Walkabout for configuring the network settings of the NK-NET.

For More Information on...
- configuring the NK-IPS when it is connected directly to a network, refer to “Locating Devices Using Walkabout” on page 16.
Connecting the NK-NET to NK Series Devices

To connect the NK-NET to NK Series devices (routers, panels, and control devices), connect a CAT5 cable to the T-BUS RJ-45 port on the rear of the NK-NET and connect the other end to either of the RJ-45 ports of the device. Most NK Series devices are equipped with two RJ-45 ports for looping or daisy chaining devices.

Installing DashBoard

The DashBoard software and user manual can be downloaded from our website.

DashBoard is used to configure and operate the NK-NET, NK systems, and individual NK Series devices. The IPS Connection window in DashBoard is used to locate and to configure NK-NET devices once they have been detected and configured for the network using Walkabout.

For More Information on...

- DashBoard system requirements, refer to the DashBoard User Manual available on our website.

Upgrading the Firmware Version

Firmware upgrade files can be obtained by contacting Ross Video Technical Support.

To upgrade the NK-NET firmware

1. Open DashBoard.

2. In the Basic Tree View, double-click the Connection icon (NK-NET) within the device tree.

   The Connection editor opens.

3. Click Send Firmware.

   The Open file browser opens.

4. Navigate to where you have stored the firmware file and select it.

5. Click Open.

   The Confirm Upload dialog box opens.

6. Click Continue.

   A progress bar is displayed. When the upload has completed, a confirmation box opens.

7. Click OK.

8. Click Reboot to restart the device and activate the new firmware.
Configuration and Operation

The NK-NET is used for connecting to a T-BUS system and can be interfaced using DashBoard.

The NK-NET needs to be detected and the IP address for the LAN configured for use within a network using Walkabout. Once the NK-NET settings have been configured in Walkabout, the NK-NET can be detected in DashBoard using auto discovery via SLP.

Optionally, NK-NET can also be added manually using Device Finder if it is on the same subnet.

For More Information on...
- connecting the NK-NET to a PC, refer to “Connecting the NK-NET Direct to a PC” on page 13.
- configuring the NK-NET when it is connected directly to a network, refer to “Locating Devices Using Walkabout” on page 16.

Default Configuration

The NK-NET can be connected and used straight out of the box provided the network settings match the default network settings of the NK-NET. There are no passwords set for configuration of devices. The default configuration is as follows:

- IP address: 192.168.20.120
- Netmask: 255.255.255.0
- Port: 5000
- T-BUS address: 254

Ethernet LEDs

The two status LEDs on the Ethernet connector will display the following behavior:

- Green (LINK/ACT):
  - Solid green when link is good.
  - Flashing when sending or receiving data.
- Yellow (SPEED):
  - On for 100 Mb/s.
  - Off for 10 Mb/s.
- Alternating flashing yellow (SPEED) and green (LINK/ACT) when NK-NET is in locate status.
Locating Devices Using Walkabout

Walkabout enables users to locate and configure the network settings of the NK-NET.

Figure 2.1 Example of the Walkabout User Interface

For More Information on...

• using Walkabout, refer to the section “To manually add an NK-NET to DashBoard” on page 16.

User Interface

<table>
<thead>
<tr>
<th>No.</th>
<th>Device</th>
<th>ID</th>
<th>Name</th>
<th>Address</th>
<th>Netmask</th>
<th>Gateway</th>
<th>Reboot</th>
<th>Default</th>
<th>Locate</th>
<th>Link Quality</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>NK-NET</td>
<td>00F0D07055</td>
<td>NK-NET</td>
<td>10.65.1.101</td>
<td>255.255.255.0</td>
<td>10.65.0.1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For More Information on...

- **No.** (read-only) – the discovery order number of the NK-NET in Walkabout.
- **Device** (read-only) – the device type.
- **ID** (read-only) – the MAC address of the NK-NET.
- **Name** – the name assigned to the NK-NET. Double click inside the cell to enter or edit the name.
- **Address** – the IP address assigned to the NK-NET. Double click inside the cell to enter or edit the address.
- **Netmask** – the IP netmask assigned to the NK-NET. Double click inside the cell to enter or edit the netmask.
- **Gateway** – the IP gateway assigned to the NK-NET. Double click inside the cell to enter or edit the gateway.
- **Reboot** – click this button to reboot the NK-NET.
- **Default** – click this button to return the NK-NET to its default address, netmask, and gateway.
- **Locate** – click this button to query the network for NK-NET devices. The NK-NET in question may be located by the alternate flashing of the Ethernet connector LEDs.
- **Link Quality** (read-only) – displays the status of the connection:
  - 100% (green) indicates that the connection is good.
  - 0% (white) indicates that no response was received from the device.
  - Red indicates a slow connection.
  - Any percentage from 1% to 99% is a relative measure of response time.

Adding an NK-NET to DashBoard

The NK-NET can be added to DashBoard via automatic discovery or manually using The NK-IPS Connection window.

Adding an NK-NET to DashBoard via Automatic Discovery

The NK-NET can be detected in DashBoard using Auto Discovery via SLP once the IP address for the LAN has been configured for use within a network using Walkabout. Refer to the DashBoard User Manual for information on enabling Auto Discovery for your DashBoard client.

Manually Adding an NK-NET to DashBoard

NK-NET can be added manually to DashBoard by entering its IP address using the NK-IPS Connection window once it has been detected and configured in Walkabout.

To manually add an NK-NET to DashBoard

1.  Open **Walkabout**.

   If necessary, click **Refresh** to query the network for NK-NET devices.
2. Locate the NK-NET you want to add to DashBoard and configure the following information if necessary:
   • **Name** – double click inside the cell to enter a name for the NK-NET.
   • **Address** – double click inside the cell to enter an IP address for the NK-NET.
   • **Netmask** – double click inside the cell to enter an IP netmask for the NK-NET.
   • **Gateway** – double click inside the cell to enter an IP gateway for the NK-NET.

3. In DashBoard, click **File > New > NK-IPS Connection**.
   The **NK-IPS Connection** window opens.

![NK IPS Connection Window](image)

4. In the **IP Address** box, enter the IP address of the NK-NET you want to add to DashBoard.

5. Use the **Port** drop-down menu to select a port number.
   The default is 5000. If the port number is changed in Walkabout, the port number in the NK-IPS Connection window must be configured to reflect this change.

6. Click **Finish**.
   The **NK-IPS Connection** window closes and the NK-NET is added to the devices listed in the **Basic Tree View**.

### NK-NET Configuration

The NK-NET uses the **NK-NET** device tab in DashBoard for user configuration.

#### NK-NET Tab

The **NK-NET** tab allows users to configure the interface options for the NK-NET, as well as having the ability to assign a name and brief details to the device itself.

* Any changes to the parameters on the **NK-NET** tab will need to be sent to the NK-NET using the **Send Configuration** button before they take effect.
Device Details

**Serial Num** (read-only) – the serial number is set in the factory before shipping and is unique to each device. This parameter is not user configurable.

**Version** (read-only) – the software version.

**Network Settings** – N/A

**Serial Num** (read-only) – the serial number is set in the factory before shipping and is unique to each device. This parameter is not user configurable.

**Hardware Rev** (read-only) – the hardware version of the NK-NET

**Details** – assigned by the user to give an NK-NET specific details. For example, a physical location or a brief description of its use.

This field has a maximum of 16 characters and is used for description and identification only.

**MAC Address** (read-only) – the Media Access Control address (MAC address) is the unique hardware address for the NK-NET on a network. This parameter is not user configurable.

**Name** – this field can be assigned by the user to uniquely name an NK-NET.

This field has a maximum of 16 characters and is used for description and identification only.

**Group** – a group number can be assigned by the user to organize devices into groups. For example, users can assign separate group numbers for devices in different physical areas.

This field has a maximum of 10 characters, and by default is blank.
Network Settings

- Newly assigned IP addresses and netmasks are checked for valid values before being applied to an NK-NET. If the new values are invalid they will be discarded silently. Only a refresh of the NK-NET tab will show that the values were not set.

**IP Address** – enter or edit the IP address of the device.

**Netmask** – enter or edit the IP netmask of the device.

**Gateway** – enter or edit the IP gateway of the device.

**TCP Port** – enter or select the Transmission Control Protocol port number used for network communication. By default, the TCP Port is 5000, and any client devices/apps should be setup with the same port number.

 GV G Interface

**NK Address** – enter the T-BUS address the NK-NET will use when translating messages arriving from a device using GVG Native protocol to NK messages. The default address is 200.

- Each device should be assigned its own T-BUS address. The range is from 1 to 254.

**Virtual Mode** – select this check box to make the switch requests arriving from GVG Native protocol devices as virtual switch requests (NK-VRC is required for this).

**Max Destination** – enter or select the maximum NK router destinations that the GVG Native protocol should handle. Using lower values improves performance.

**Level** – use the four boxes to select NK level numbers. The NK-NET keeps a local cache of routing system status. Because of its limited storage capacity, only 4 levels of status are kept. This impacts the GVG QD, and BK,D commands. Levels that do not match these values will be ignored. Set to zero if not used.

**Timeout(s)** – enter or select the amount of time in seconds to go without receiving any messages before NK-NET closes the connection.

- Entering a value of 0 will disable the timeout. However, this is not recommended. Disabling the timeout will cause the NK-NET to leave the attached GVG connection of the client open indefinitely, regardless of whether any traffic is received, until the NK-NET is rebooted (or power cycled).

The approach recommended for equipment using the GVG protocol is to send one of the supported status query commands to the NK-NET (for example, QI or QJ) before the timeout period expires (for example, once every 10 to 14s if the default timeout of 15s is used) to keep the connection open.

The NK-NET GVG Interface supports the following Native protocol commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>QI</td>
<td>QI,destIndex,lvlIndex</td>
<td>Checks sources assigned to destinations by specific Destination and Level Index.</td>
</tr>
<tr>
<td>Qi</td>
<td>Qi,destIndex,lvlIndex</td>
<td>Checks sources assigned to destinations by Destination Index for all levels.</td>
</tr>
<tr>
<td>QJ</td>
<td>QJ[destIndex]</td>
<td>Takes Source (on specified level) to specified destination, by index rather than name.</td>
</tr>
<tr>
<td>Qj</td>
<td>Qj[destIndex]</td>
<td></td>
</tr>
<tr>
<td>TI</td>
<td>TI,destIndex,srcIndex[,levelIndex]</td>
<td></td>
</tr>
</tbody>
</table>

Table 2.1  Supported GVG Native Protocol Commands
The current implementation of the QJ (Qj) command supports only queries that have the destination index parameter supplied. It does not support the 'changed' status version of the command (i.e. QJ with no index parameter supplied).

For More Information on...
- the GVG Native protocol and use of these commands, consult the documentation provided by the equipment manufacturer.

Connect as a Client to a Second NK-NET

This section enables client functionality, which directs one NK-NET to another to effectively join the T-BUS segments (for example, connecting two NK-IPS devices via ENET without requiring NK-Hub software) and to expand the number of connected devices (for example, more control panels).

The NK-NET will connect to one server at a time. In the event that the current connection fails, if IP addresses are specified in both rows of the client address table, the NK-NET will attempt to connect to the other address to provide basic network connection redundancy. To force the NK-NET to always connect to the first address only, enter 0.0.0.0 for the second.

If connecting to an Ultricore Central Controller, initiate the connection from the Ultricore to the NK-NET.

# (read-only) – the list number of the NK-NET.

IP Address – in this column, enter the IP address of the respective NK-NET to which you want to connect. Any changes will cause the NK-NET to close all connections and try connecting again from the address listed as #1.

Connected (read-only) – a selected box indicates an active connection to the respective client NK-NET.

TBus for Power Only — this check box isolates the NK-NET from T-Bus communications. It is preferred that a TBus section have only one connection to an NK-NET. Since an NK-NET only supports a maximum of five TCP connections, this limits the amount devices connecting to the NK-NET. If there is a requirement to connect more devices, than another NK-NET may be added. However, connecting the T-Bus side of the multiple NK-NET together forms a communications loop.

<table>
<thead>
<tr>
<th>Command</th>
<th>Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TJ</td>
<td>TJ,destIndex,nbr_sources,srcIndex,levelbitmap[,...,srcIndex, level_bitmap]</td>
<td>Takes Sources (on specified levels) to specified destination by index rather than name. Allows Breakaways.</td>
</tr>
<tr>
<td>BK</td>
<td>BK, D</td>
<td>Clears the flags associated with the QJ,no_parameter command. After BK,D is sent, the next QJ,no_parameter command will result in destination statuses for all destinations being returned.</td>
</tr>
</tbody>
</table>

Table 2.1 Supported GVG Native Protocol Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TJ</td>
<td>TJ,destIndex,nbr_sources,srcIndex,levelbitmap[,...,srcIndex, level_bitmap]</td>
<td>Takes Sources (on specified levels) to specified destination by index rather than name. Allows Breakaways.</td>
</tr>
<tr>
<td>BK</td>
<td>BK, D</td>
<td>Clears the flags associated with the QJ,no_parameter command. After BK,D is sent, the next QJ,no_parameter command will result in destination statuses for all destinations being returned.</td>
</tr>
</tbody>
</table>
Connections

**Max DashBoard Connections** – enter or select a maximum number of DashBoard clients that can connect to the NK-NET. The maximum number of connections available is six.

**Number of connections** (read-only) – displays the number of clients connected to the NK-NET and the IP addresses of the connected clients.

Other Functions

**DashBoard Whitelist** — Reserves a DashBoard connection from a specified IP address. Up to two IP addresses may be reserved. This takes away from the available connection pool of six.
**Refresh** – click this button to revert to the configuration previously sent to the NK-NET. The NK-NET tab will display the last settings that were sent to the NK-NET via the **Send Configuration** function.

**Send Firmware** – click this button to open a file browser to select a software/firmware file to send to the NK-NET.

**Send Configuration** – click this button to upload the settings to the NK-NET. All configuration items become active only after uploading.

**Reboot** – click this button to reboot the NK-NET. This function does not clear the NK-NET settings.

**Close** – click this button to close the NK-NET tab in DashBoard.

### NK Switchboard Configuration and Operation

The NK Switchboard enables the routing matrix to be monitored and optionally controlled on any router on any NK-NET detected on the network. The NK Switchboard is configured using the NK Switchboard tab in DashBoard.

⭐ It is recommended to configure the NK Switchboard globally before performing any switches.

Once DashBoard has been installed, the NK Switchboard can be accessed by clicking on the NK Switchboard button ( 
) from the toolbar. If the Switchboard has already been opened in the work area, activating it from either the menu or the toolbar will open it as a device tab in the device view of DashBoard.

![NK Switchboard Tab](image)

*Figure 2.4 NK Switchboard Tab*
Switching

The NK Switchboard is designed to emulate basic behavior of the RCP-NK1. Switches are performed by first selecting the Level(s) required to be switched, then by selecting the Output, and finally selecting the Input.

When an Output has been selected, all Input buttons pressed thereafter will switch to that output. This is indicated by the blue line highlighting the current output selection.

Source, Destination, and Level Buttons

The Input (Source), Output (Destination), and Level buttons displayed on the NK Switchboard can be edited individually on-the-fly as required by right-clicking on the desired button and editing the fields. The button edit menu enables users to define text labels for the buttons display (Edit Text), the relative input, output or level value (Edit Value), as well as Add or Delete buttons.

The number of inputs, outputs, and levels can be configured using the Configure IPS dialog box. Click the Configure Switchboard button ( ) to open the Configure IPS dialog box.

For More Information on...

• the Configure IPS dialog box, refer to “Configure IPS” on page 24.

The Level Buttons

The Level buttons, when selected, enable switching on the corresponding levels. The total number of Level buttons shown is reliant on the number entered in the Configure IPS dialog box.

The Input (Source) Buttons

The Input buttons select the source or sources to be switched on the levels previously selected. The total number of Input buttons shown is reliant on the number entered in the Configure IPS dialog box.

The Output (Destination) Buttons

The Output buttons select the destination for the source to be switched on the levels previously selected. The total number of Output buttons shown is reliant on the number entered in the Configure IPS dialog box.

Virtual Routing Button

Press the Virtual Routing button to have NK Switchboard perform all switches in virtual routing mode. If de-selected, any routing devices controlled through NK Switchboard will use physical switching.

★ The NK-VRC virtual routing core is required for virtual routing and resource management.

The Function Keys

The NK Switchboard function keys provide Machine Control switching (the MC button) and protecting of selected inputs/outputs (the Protect button). For the Protect and MC buttons to be active, they must be enabled from the Configure IPS dialog box.

Protects

The NK Switchboard displays protected outputs by either a yellow highlight, or a pink highlight (use the Key at the bottom of the NK Switchboard tab as a reference). Outputs that are highlighted yellow are protected by that computer and outputs that are highlighted pink are protected by another user or another panel in the system.

For the protect system to be accurate, each panel and computer operating DashBoard must have its own unique address, configured in the Configure IPS dialog box.
Configure IPS

Use the **Configure IPS** dialog box to configure the number of inputs/outputs and levels, and to turn on protects and machine control functions.

In **NK Switchboard**, click the **Configure Switchboard** button ( ) to open the **Configure IPS** dialog box.

![Configure IPS dialog box]

**Custom** – select this check box to save custom settings when saving a *.nks file. Any changes to the settings of an NK-NET in the **Configure IPS** dialog box will automatically select the check box.

**Serial** (read-only) – the serial number of the device.

**Name** – the name of the device.

**#Outs** – double-click inside the box to enter the number of outputs (destinations).

**#Ins** – double-click inside the box to enter the number of inputs (sources).

**#Levels** – double-click inside the box to enter the number of levels.

**Addr** – By default, the NK Switchboard T-BUS address is the same as the NK-NET T-BUS address, but it can be changed. The most common reason for changing the address would be when using resource management.

**Prot** – select this check box to enable the protect function.

**M/C** – select this check box to enable the machine control function.

**Virt** – select this check box to enable virtual routing and resource management.

* The **Virt** check box will be selected in the **Configure IPS** dialog box by default if an NK-VRC is installed as part of the system connected via T-BUS to the NK-NET.

**Labels** – click this button to import global labels. In order for the loaded *.nks file to be applied to NK Switchboard, the selected NK-NET needs to be re-selected in NK Switchboard before any changes will be effected.

**Load** – click this button to load a saved configuration from a *.nks file.

**Save** – click this button to save the configuration to a *.nks file.

**OK** – click this button to load the changes and close the **Configure IPS** dialog box.

**Cancel** – click this button to close the **Configure IPS** without applying changes.

**For More Information on...**

- using resource management, refer to the **NK-VRC User Guide**.
Using an NK-VCP

The NK Virtual Control Panel (NK-VCP) is a software application that communicates via the NK-NET and enables monitoring and control of the router matrix. If required, it is also possible to control multiple systems, alternately between each as needed.

NK Virtual Control Panel Overview

🌟 NK-VCP is legacy software and not actively maintained.

As the NK-VCP works in conjunction with the NK-NET, NK-VCP control can be password protected to only allow authorized users to perform router functions.

The NK-VCP runs in the Java platform, using version 1.4.2 or later of the Java Runtime Environment (JRE). This allows the application to run on any system that supports the Java Virtual Machine (VM). The program runs on Windows.

For the NK-VCP to load, the JRE must first be installed.

![Figure A.1 The NK Virtual Control Panel](image)

🌟 Although the NK-VCP will operate with Java Runtime Environment 1.4.2 and later, it is recommended that users have the latest JRE installed on their computer before using the NK-VCP.

For More Information on...
- installing the NK-VCP, refer to “Installing NK-VCP” on page 28.

Starting the NK-VCP

After installation, the NK-VCP can be started from the link placed on the desktop or from the Start menu.

All communication requests and activity are shown in the bottom left corner of the NK-VCP interface.

Adding an NK-NET

Multiple NK-NET devices can be added to the one NK-VCP. When the NK-VCP is first loaded, the default NK-NET will need to be configured. To add or change the settings for the default NK-NET, or add another NK-NET to the NK-VCP, first select Preferences from the Edit menu.
The Preferences Dialog Box

The Preferences dialog box is used to add or change configuration of the NK-VCP, the NK-NET device(s) to be interfaced, and the network details required for the NK-VCP and the NK-NET to communicate with each other.

![Figure A.2 Preferences dialog box](image)

# (Number) – indicates the NK-NET devices available to the NK-VCP.

**NK-IPS Name** – shows a unique name for each NK-NET added to the NK-VCP. Unique or descriptive names can be assigned to distinguish NK-NET devices from one another.

**IP Address** – The IP address is required for the NK-VCP to connect to an NK-NET and is the link for network communications. The IP address will first need to be detected via the NK-IPS Connection window in DashBoard and entered into this field.

**Num Outs** – specifies how many outputs are to be viewed and controlled by the NK-VCP for a particular NK-NET.

- If the output range of routers connected to the NK-NET exceeds the number of outputs (**Num Outs**) specified in the Preferences dialog box, the remaining outputs will not be shown on the NK-VCP.

**Num Ins** – specifies how many inputs are to be viewed and controlled by the NK-VCP for a particular NK-NET.

- If the input range of routers connected to the NK-NET exceeds the number of inputs (**Num Ins**) specified in the Preferences dialog box, the remaining inputs will not be shown on the NK-VCP.

**Num Levels** – specifies how many levels are to be viewed and controlled by the NK-VCP for a particular NK-NET. The maximum number of levels for the NK Series routers is eight, and the default value for any NK-NET added to the NK-VCP is also eight.

**Address** – defines the T-BUS address that the NK-VCP will use when sending switch requests to the NK-NET. By default, the NK-VCP’s address is 253. If multiple NK-VCPS are to be used within the one NK system, it is strongly recommended that they be given different addresses within that system because it is necessary for proper function of protects.

**TCP Port** – defines which port is used for network communication. By default, the TCP Port is 5000 but must match the port defined on the NK-NET network settings.

For More Information on...

- the NK-IPS Connection window, refer to “Locating Devices Using Walkabout” on page 16.

Source, Destination, and Level Buttons

The **In** (Source), **Out** (Destination), and **Level** buttons displayed on the NK-VCP can be edited as required by right-clicking on them. The button edit menu enables users to define the text the buttons display (**Edit text**), the respective input, output, or level value (**Edit value**), and **Add** or **Delete** buttons.
The Level Buttons

The Level buttons, when selected, enable switching on the required levels. The total number of Level buttons shown is reliant on the number entered in the Preferences dialog box.

![Figure A.3 Level buttons](image)

The Input (Source) Buttons

The Input buttons select the source (or sources) to be switched on the levels previously selected. The total number of Input buttons shown is reliant on the number entered in the Preferences dialog box.

![Figure A.4 Source buttons](image)

The Output (Destination) Buttons

The Output buttons select the destination for the source to be switched on the levels previously selected. The total number of Output buttons shown is reliant on the number entered in the Preferences dialog box.

![Figure A.5 Output buttons](image)

Switching

The NK-VCP is designed to emulate basic behavior of the RCP-NK1.

To perform switches
1. Select the Level(s) required to be switched.
2. Select the Output.
3. Select the Input.

When an Output has been selected, all Input buttons pressed thereafter will switch to that output. This is indicated by the blue line highlighting the current output selection.

Protecting Outputs

The Protect button is used to lock the current output (destination) from switching by other control panels or virtual control panels.

Clicking Protect will protect the current destination. Clicking Protect a second time will clear the protect.

If a switch is attempted for an output that has been protected, a message will be displayed describing the cause of the error.
Machine Control Button
The Machine Control button (MC) is used to reciprocally switch the source (master) and destination (slave) selected. Click MC to enable machine control operation and then press the required destination and source.

For More Information on...
- the Machine Control operation and reciprocal switching, refer to the NK Series User Guide.

Installing NK-VCP
To use the NK-VCP, the Java Runtime Environment must first be present on your system. If this software is not present on your system, or if you are unsure, follow the guidelines below to ascertain whether it needs to be installed or updated.

- NK-VCP is only supported Microsoft® Windows®-based operating systems and will launch in 32bit environments only.

System Requirements
- Intel® Pentium® 200Mhz or equivalent
- Microsoft® Windows XP® or later
- 32MB of RAM
- 150MB of available hard-disk space

Installing the Java Runtime Environment (JRE)
The Java Runtime Environment is required for NK-VCP operation.

Determining Previous JRE Installations
If you are unsure what version (if any) of the JRE is installed on your computer, you will need to open a command line prompt.

To determine previous JRE installations in Microsoft® Windows 7®
1. From the Start menu:
   • select All Programs→Accessories→Command Prompt or,
   • select Run and type cmd
2. Once you have opened the Command Prompt, type java -version and press Enter.

To determine previous JRE installations in Microsoft® Windows XP®:
1. From the Start menu, select All Programs→Accessories→Command Prompt
2. Once you have opened the Command Prompt, type java -version and press Enter.

If you have JRE installed, a message will inform you of which version and build you are running, if you have an earlier version than 1.6, then you will need to download and install the latest version.

If you receive a message that says java is not recognized as an internal or external command then you will need to download and install the latest version.

To install the NK-VCP
1. Double-click install.exe.
2. Follow the on-screen instructions.
   The installation wizard will guide you through the rest of the installation process.
Configuring Basic System Network Connections

To create a useful system configuration involving RCP-ME/QE panels and the NK-NET, the devices must be configured to establish connections over the network to which they are attached. Unlike T-BUS, where several devices are simply connected to the same physical bus link to form a system of routers and panels, network-enabled devices must be not only be configured via Walkabout to communicate on the network to which they are attached, but also explicitly configured via DashBoard to establish client/server connections over the network with one another to build a system configuration. This chapter briefly describes the steps to create the connections necessary to establish a basic system configuration using the RCP-ME/QE and NK devices.

In these systems, a client refers to a device on the network that originates and establishes a connection to another device (a server) at a specified IP address. The server is the device that listens for, and accepts, incoming connections from one or more clients.

Control an NK Router Over the Network Using an NK-NET and RCP-ME/QE

The system configured in this scenario is illustrated in the following diagram:

Operationally, the client/server relationships established in this system are as follows:

To control an NK router over the network using an NK-NET and RCP-ME/QE

1. In Walkabout, configure the basic network settings for the RCP-ME/QE and NK-NET.
2. Once the devices have been discovered by DashBoard, double-click the RCP-ME/QE icon in the Basic Tree View in DashBoard.
   The device tab opens in the main window in DashBoard.
3. In the Servers to connect to section of the RCP-ME/QE device tab, enter the IP address of the NK-NET in the IP Address cell of the first row of the Servers table. Leave the IP addresses of the other rows as 0.0.0.0.
4. Click Send Configuration.

For More Information on...

- the device tab and sending a configuration, refer to the RCP-ME or RCP-QE User Guide.
Join a Router to the System Over the Network Using Two NK-NETs

The following scenario builds on the example above, to add a second router to the system. The system uses an NK-NET as a client to connect the new router to the existing system over the network rather than using T-BUS to connect the second router to the first.

The following diagram depicts the resulting system configuration:

The client/server relationships established in this system are as follows:

To add the new router connected to the NK-NET as a client to the existing NK-NET
1. In *Walkabout*, configure the IP settings for the second NK-NET.
2. Once the second NK-NET has been discovered by DashBoard, double-click the NK-NET icon in the *Basic Tree View* in *DashBoard*.
   - The device tab opens in the main window in DashBoard.
3. In the NK-NET to connect to section of the NK-NET device tab, enter the IP address of the first NK-NET in the IP Address cell of the first row of the Servers table. Leave the IP address of the second row as 0.0.0.0.
4. Click *Send Configuration*.

For More Information on...
- the device tab and sending a configuration, refer to the *RCP-ME* or *RCP-QE User Guide*. 
Connect an RCP-ME/QE to an Existing NK System that Includes an NK-IPS

In this scenario, an RCP-ME/QE is added as a client to an existing system that has an NK-IPS. The following diagram shows the system that will be created:

![Diagram showing client-server relationships for the system.]

The following diagram depicts the client-server relationships that will be established in this system:

![Diagram showing client-server relationships in detail.]

To configure this system, follow the same basic discovery and configuration steps as the RCP-ME/QE client configuration as are shown in steps 3 and 4 in “Control an NK Router Over the Network Using an NK-NET and RCP-ME/QE”, substituting the IP address of the NK-IPS for the address of the NK-NET.

For More Information on...

- the device tab and sending a configuration, refer to the RCP-ME or RCP-QE User Guide.
Use an NK-NET to Connect Another NK Router Over Ethernet

This scenario connects a new router to an existing NK system that includes an NK-IPS over Ethernet rather than T-BUS:

The configuration depicted in this scenario establishes the following client-server relationships:

To use an NK-NET to connect another NK router over Ethernet to an existing NK system that includes an NK-IPS

1. In Walkabout, configure the IP settings for the second NK-NET.
2. Once the second NK-NET has been discovered by DashBoard, double-click the NK-NET icon in the Basic Tree View in DashBoard.
   The device tab opens in the main window in DashBoard.
3. In the NK-NET to connect to section of the NK-NET device tab, enter the IP address of the NK-IPS in the IP Address cell of the first row of the Servers table. Leave the IP address of the second row as 0.0.0.0.
4. Click Send Configuration.

For More Information on...
- the device tab and sending a configuration, refer to the RCP-ME or RCP-QE User Guide.
Use an NK-NET to Connect an Additional RCP-ME/QE Over Ethernet

In this scenario, an NK-NET is used to add an RCP-ME/QE to an existing system without an NK-IPS:

This setup will result in the following client-server relationships:

To configure this system
1. Connect the NK-NET to the T-BUS of the existing system.
2. In Walkabout, configure the basic network settings for the RCP-ME/QE and NK-NET.
3. Once the devices have been discovered by DashBoard, double-click the RCP-ME/QE icon in the Basic Tree View in DashBoard.
   The device tab opens in the main window in DashBoard.
4. In the Servers to connect to section of the RCP-ME/QE device tab, enter the IP address of the NK-NET in the IP Address cell of the first row of the Servers table. Leave the IP addresses of the other rows as 0.0.0.0.
5. Click Send Configuration.

For More Information on...
- the device tab and sending a configuration, refer to the RCP-ME or RCP-QE User Guide.
- connecting the NK-NET to the T-BUS system, refer to “Connecting the NK-NET” on page 12.
Troubleshooting

NK-NET

The following problems and questions are related to the NK-NET, with brief explanations and troubleshooting help. For questions regarding other problems or to report problems, contact Ross Technical Support.

Network/Connection Problems

Most NK-NET network problems should be solved by your Network Administrator and are usually TCP/IP address or port problems. Contact your Network Administrator for networking and address problems.

GVG Settings

If the GVG router isn’t switching past a certain destination, the max destination settings should be checked.

NK-VCP

The following problems and questions are related to the NK-VCP, with brief explanations and troubleshooting help. For questions regarding other problems or to report problems, contact support staff.

Error Messages

*NK-NET "NK-IPS Name" has maximum licensed number of virtual panels connected. Upgrade License.*

The NK-NET has the maximum number of NK-VCPs connected to it.

- Ensure that all NK-VCPs connected are being used, if they are not, close them to clear communication to the NK-NET.

*Cannot Switch - Output Protected*

The output for the attempted switch has been protected by another NK-VCP or control panel.

- To clear the protect, locate the NK-VCP or control panel that initially activated the protect and press the **Protect** button/key.

*Cannot Protect - No response from Level x*

The level that requires protection has briefly gone offline or is busy.

- Query the devices from in DashBoard and ensure that it is online.
- Check all physical connections to the router (T-Bus and power).
- Check for, and amend, alarms on the router’s **Device Properties** page.

*Cannot Protect - Output already Protected by another*

The output for the attempted protect has been protected by another NK-VCP or control panel.

- To clear the protect, locate the NK-VCP or control panel that initially activated the protect and press the **Protect** button/key.

*Error using System Look and Feel. Defaulting to Cross Platform Look and Feel.*

The JRE encountered an error when applying the operating system look and feel, the default Java look and feel is used instead.

- Try installing the latest Java version.
Network/Connection Problems

The NK-VCP does not successfully connect to a NK-NET

The NK-NET and NK-VCP must have matching TCP ports to enable communication within a network. Due to some Windows security problems, some network configurations will block port 4444 for all TCP/IP communications.

General Problems

Not all Inputs or Outputs are shown

The Input and Output buttons do not show all available sources and destinations. By default, when a NK-NET is added in the Preferences dialog box, the Number of Inputs and Number of Outputs are set to 16. For a 32x32 size router, the inputs and outputs 17 to 32 will not be displayed.

- The Number of Inputs and Number of Outputs need to be configured to match or exceed the router size in the Preferences dialog box.

- In the case of the NK-S32, which actually has 34 inputs and 34 outputs, the Number of Inputs and Number of Outputs need to be configured to match or exceed the router size in the Preferences dialog box.